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What is LaTeX?Typesetting rules
 Additional Information
 An Introduction to LATEX
 Iryna Schlackow
 Department of Continuing Education,Pembroke College and Nuffield Department of Medicine
 October 16, 2010
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 Donald E. Knuth(image of the cake taken from Knuth’s website)
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 TEX is a computer program created by Donald E. Knuth. It isaimed at typesetting text and mathematical formulae and isrenowned for being extremely stable and virtually bug free.
 Knuth started working on it in 1977, and TEX as we use it todaywas released in 1982. The version number of TEX is convergingto π and is now at 3.1415926.
 TEX is pronounced “Tech,” with a “ch” as in the German “Ach.”In an ASCII environment, TEX becomes TeX.
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 One of Knuth’s rewards checks
 http://www-cs-faculty.stanford.edu/~uno/news.html
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What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 Leslie Lamport
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 LATEX is a TEX macro package. It enables authors to typeset andprint their work at the highest typographical quality, using apredefined, professional layout.
 LATEX was originally written by Leslie Lamport in 1980s, and itscurrent version, LATEX 2ε, was released in 1994.
 LATEX (LaTeX in an ASCII environment) is pronounced “Lay-tech”or “Lah-tech.” LATEX 2ε (LaTeX2e) is pronounced “Lay-tech two e”.
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 The typesetting of mathematical formulae is supported in aconvenient way.
 Complex structures (footnotes, cross-references, bibliography,nested lists, tables) can be generated easily.
 LATEX encourages authors to write well-structured texts.
 Professionally crafted predefined layouts are available.
 It is easy to superimpose another document style(e.g. designed by a publisher) on a LATEX file.
 The system is free and runs on almost any hardware andsoftware platform available.
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 LATEX is built on a programming language and is extensible. Thereexist many (free!) add-ons:
 customised styles for scientific journals,
 class styles for creating presentations,
 class style for writing letters,
 packages for writing CVs,
 packages for typesetting chemistry symbols,
 packages for typesetting linguistic papers,
 packages for typesetting music,
 packages for producing coffee stains,
 · · ·LATEX can be integrated with other programs(e.g. Sweave combines R and LATEX).
 LATEX is available(ish) in Google Docs.
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What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 Does LATEX have any disadvantages?
 LATEX does not work well for people who have sold their souls.
 Your hamster might, despite some encouraging first steps,never be able to fully grasp the concept of Logical Markup.
 It is very hard to write unstructured and disorganiseddocuments.
 LATEX is not (traditionally) a WYSIWYG system
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 Microsoft Word menufrom www.nedmartin.org
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 WYSIWYG systems (Word) LATEX (traditional approach)
 The output is precisely whatyou type in.
 (1 23 4
 )You type in LATEX “code”, whichneeds to be compiled first.
 $\left(\begin{array}{cc}1 & 2 \\3 & 4\end{array}\right)$
 The document layout is speci-fied by means of visual design.
 A suitable layout is chosen by LATEXonce the logical structure of thedocument has been specified.
 You may spend too much timefiddling with fonts and margins.The document is likely to havelittle or inconsistent structure.
 It is very hard to write unstruc-tured and disorganised documentsin LATEX.
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 http://nedmartin.org
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What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 Microsoft Word optionsfrom www.nedmartin.org
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 There exist LATEX-based WYSIWYG and the like programs:
 Scientific Word (for Windows, commercial)
 LyX (Unix, Mac OS X and Windows, free)
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 Coming back to our matrix:(1 23 4
 ) $\left(\begin{array}{cc}1 & 2 \\3 & 4\end{array}\right)$
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 (1 23 4
 ) $\begin{array}
 \end{array}$
 this is an array
 http://nedmartin.org
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What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 (1 23 4
 ) $\begin{array}{cc}
 \end{array}$
 an array with
 2 columns: all centred;
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 (1 23 4
 ) $\begin{array}{cc}1 & 23 & 4\end{array}$
 an array with
 2 columns: all centred;
 & acting as a column separator;
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 (1 23 4
 ) $\begin{array}{cc}1 & 2 \\3 & 4\end{array}$
 an array with
 2 columns: all centred;
 & acting as a column separator;
 \\ acting as a row separator;
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 (1 23 4
 ) $(\begin{array}{cc}1 & 2 \\3 & 4\end{array})$
 an array with
 2 columns: all centred;
 & acting as a column separator;
 \\ acting as a row separator;
 surrounded by round brackets (, )
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What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 (1 23 4
 ) $\left(\begin{array}{cc}1 & 2 \\3 & 4\end{array}\right)$
 an array with
 2 columns: all centred;
 & acting as a column separator;
 \\ acting as a row separator;
 surrounded by round brackets (, ) of the appropriate size.
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 (11 12 253 4 6
 ) $\left(\begin{array}{ccc}11 & 12 & 25 \\3 & 4 & 6\end{array}\right)$
 an array with
 3 columns: all centred;
 & acting as a column separator;
 \\ acting as a row separator;
 surrounded by round brackets (, ) of the appropriate size.
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 11 12 253 4 6
 342 234 232
 $\left(\begin{array}{ccc}11 & 12 & 25 \\3 & 4 & 6 \\342 & 234 & 232\end{array}\right)$
 an array with
 3 columns: all centred;
 & acting as a column separator;
 \\ acting as a row separator;
 surrounded by round brackets (, ) of the appropriate size.
 What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 11 12 253 4 6
 342 234 232
 $\left(\begin{array}{crl}11 & 12 & 25 \\3 & 4 & 6 \\342 & 234 & 232\end{array}\right)$
 an array with
 3 columns: centred, right-aligned, left-aligned;
 & acting as a column separator;
 \\ acting as a row separator;
 surrounded by round brackets (, ) of the appropriate size.
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What is LaTeX?Typesetting rules
 Additional Information
 The name of the gameWhy LaTeX?LaTeX vs Word
 11 12 253 4 6
 342 234 232
 $\left[\begin{array}{crl}11 & 12 & 25 \\3 & 4 & 6 \\342 & 234 & 232\end{array}\right]$
 an array with
 3 columns: centred, right-aligned, left-aligned;
 & acting as a column separator;
 \\ acting as a row separator;
 surrounded by square brackets [, ] of the appropriate size.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Input file
 Every LATEX input file possesses a certain structure. You start withspecifying what sort of document you intend to write
 \documentclass[options]{class}This is followed by the preamble where you can include commandsinfluencing the style of the whole document or load packagesadding new features to the LATEX system
 \usepackage[options]{package}When all the setup work is done you start the body of the text
 \begin{document}Now you enter the text mixed with LATEX commands. At the end ofthe document you add
 \end{document}Anything that follows this command will be ignored by LATEX.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Output file
 Once the LATEX file is compiled, a viewable output file is produced.It can be a .dvi or a .pdf file.
 If the file is compiled with the latex command, it usuallyproduces a .dvi file.
 If the file is compiled with the pdflatex command, it usuallyproduces a .pdf file.
 Several auxiliary files will be created.
 Many LATEX editors can produce both .dvi and .pdf files.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 This is actually enough to create a compilable LATEX file!
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What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Document class
 \documentclass[options]{class}
 Document classes: article, book, letter, beamer, a0poster, . . .
 Options (need to be separated by commas): 10pt, 11pt, 12pt,a4paper, twoside, landscape, fleqn, . . .
 For example, the command
 \documentclass[11pt, fleqn, twoside, a4paper]{article}instructs LATEX to typeset the document as an article with font sizeof 11pt, with equations to be left-aligned rather than centred, andto produce a layout suitable for double side printing on A4 paper.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Preamble
 The preamble tells LATEX which packages to use.
 \usepackage[options]{package}Examples of packages include amsmath, amsthm, color.
 The preamble also defines the style of the document. You canchange margins, width or height of text, indentation, . . .
 \setlength{\textheight}{600pt}\addtolength{\textwidth}{-1in}\setlength{\parindent}{0cm}\linespread{1.6}
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Spaces
 It does not matter how many spaces youtypesetor if you start on a new line.
 However, an empty line starts a new paragraph.
 It does not matter how many spaces you typeset or if you start on anew line.
 However, an empty line starts a new paragraph.
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What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Special Characters
 The following symbols are reserved characters that have a specialmeaning in LATEX and, when entered directly in text, will coerceLATEX to do things you did not intend
 $ & % # { } ∼ ˆ \(for example % comments out the line following it)
 You can still produce these characters in the text:
 for $, &, %, #, , { and } type a backslash \ in front of them(for example type \$ to produce $);
 for ∼, ˆ and \ you need to use special commands.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 LATEX Commands
 LATEX commands are case-sensitive and consist of a backslash \followed by
 a string of letters, or
 exactly one non-letter (e.g. a special character).
 Commands may have
 no arguments,
 mandatory arguments, which are input in braces { },optional arguments, which are input in square brackets [ ].
 For example,
 \framebox[3in]{\textit{Various fonts} are supported by \LaTeX.}
 produces
 Various fonts are supported by LATEX.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Title page
 The title is generated by calling the \maketitle command.
 The contents of the title are defined by the following commands(usually put in the preamble):
 \title{...}\author{...}\date{...} (this is optional; the default value is \today).
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Exercise
 Create a folder named “Examples” on the desktop.
 Go to Start → All Programs → LEd → LEd.
 Go to File → New → TeX/LaTeX document →(file name) example.tex + (location) Examples folder → OK.
 Using the document class article, type up the minimal set ofcommand needed to create a compilable LATEX document.
 Type up Hello World.
 Compile the document with latex and pdflatex commands.(If prompted to save the document, save it in the Examplesfolder as a .tex document).
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What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Exercise
 Generate parameters for the title page:“This is my first LATEX file!” as the title,yourself as the author, andtoday as the date.
 Generate the title.
 Set indentation at the beginning of each paragraph(\parindent) to be 2 inches.
 Increase the default top margin (\topmargin) by 2 cm.
 Decrease the default text width (\textwidth) by 3 cm.
 Type some text to check that the settings have been updated.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Sections
 The following sectioning commands are available for the articleclass:
 \section, \subsection, \subsubsection, \paragraph, \subparagraph,for example
 \section{title}or, if the title is too long,
 \section[Title for the table of contents]{A longer title, shown in the text}
 To create a table of contents, use the \tableofcontents command(To get all references right, the document will need to be compiledat least twice).
 To create an unnumbered section, which will not appear in thetable of contents, use the starred versions of the commands, e.g.\section*{title}
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Fonts
 \textrm{...} roman \underline{...} underline\textsf{...} sans serif \textbf{...} bold\textit{...} italic \emph{...} emphasise
 {\ tiny ...} smallest {\ normalsize ...} normal
 {\ LARGE ...} large {\ Huge ...} largest
 \textcolor{red}{xxx} xxx (requires package color)
 Note that these may be combined:
 \textcolor{green}{\underline{\textit{\LARGE Hello}}}produces
 hello
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Environments
 Environments are building blocks of a LATEX file. Each declarationof environment has the following syntax:
 \begin{environment} text \end{environment}
 \begin{center} ... \end{center},\begin{document} ... \end{document},\begin{enumerate} ... \end{enumerate}.
 Environments can be nested within each other so long as thecorrect nesting order is maintained:
 \begin{aaa}...\begin{bbb}
 ...\end{bbb}...
 \end{aaa}
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What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Tables
 To typeset beautiful tables with optional vertical and horisontallines use the tabular environment, e.g.
 \begin{tabular}{|lc||r|}\hlinethis & is & the first row \\and this & is of course & the second row \\\hline
 \end{tabular}produces
 this is the first rowand this is of course the second row
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Lists
 To produce a bullet point list, use the itemize environment.
 To produce a numbered list, use the enumerate environment.
 Each item of a list begins with the \item command.
 Each list must contain at least one \item.
 Lists can be nested up to four levels.
 \begin{enumerate}\item[label (optional)]\item[label (optional)]\end{enumerate}
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 To change the default style of numbering, redefine the commands\labelenumi, \labelenumii, \labelenumiii, \labelenumiv, whichprovide styles for the four allowed levels of nesting. E.g.
 \renewcommand{\labelenumi}{\Alph{enumi}}\renewcommand{\labelenumii}{(\roman{enumii})}
 produces lists numbered
 A, B, C . . . at the first level, and
 (i), (ii), (iii) . . . at the second level.
 The change may be applied to the whole document (if thecommands are put in the preamble) or a specific enumerationenvironment (if the commands are put inside this environment).
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Typesetting mathematical formulae
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What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Mathematical text within a paragraph is entered between $ and $,e.g., $\alpha=\sum {i=1}^n \beta^i$ produces α =
 ∑ni=1 β
 i .
 To insert an equation on a separate line, write \[ ... \] or\begin{displaymath} ... \end{displaymath}, e.g.
 \[ \alpha = \sum {i=1}^n \beta^i \]produces
 α =n∑
 i=1
 βi .
 To produce in line formulae with \displaymath layout, use$\displaystyle...$ instead of $...$, e.g. from the example
 above we get α =n∑
 i=1
 βi .
 To number your equation, use the equation environment.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 \sqrt{2}√
 2, \sqrt[3]{2} 3√
 2
 xˆ2 x2 x m, x {m,n} xm, xm,n
 \alpha, \beta α, β \Gamma, \Delta Γ, ∆
 \frac{1}{2} 1
 2\int aˆ\infty
 ∫ ∞a
 \sum {i=1}ˆnn∑
 i=1
 \prod {i=1}ˆnn∏
 i=1
 Many symbols require additional packages, such as amssymb.
 Don’t forget that many LATEX commands can be combined!∫ ∞−∞
 √x3 + 2y + 5
 Θ + ξdx = eπi
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 For formulae running over several lines or simultaneous equationsuse the eqnarray environment, e.g.
 \begin{eqnarray}\alpha & = & 7+x \\\beta+\gamma & = & \int {0}̂{\infty} p(x) {\rm d}x\end{eqnarray} produces
 α = 7 + x (1)
 β + γ =
 ∫ ∞0
 p(x)dx . (2)
 You can align the equations about any symbol.
 To produce unnumbered equations, use the eqnarray*environment. To not number only certain equations in an array,insert the command \nonumber.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Exercise
 Split your document into three sections:1 numbered and titled “Fonts”;2 numbered and titled
 “Other features” in the body of the document and“Other” in the table of contents”.
 3 unnumbered and titled “Mathematics”;
 Generate the table of contents.
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What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Exercise
 Fill in section “Fonts” as follows:
 Type a sentence using different fontsType a sentence with one word emphasised
 And now type a sentence in italic with one word emphasised
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Exercise
 Add the following table to section 2:
 Title AuthorPygmalion (My Fair Lady) George Bernard ShawThe Phantom of the Opera Gaston LerouxThe Yeomen of the Guard Guilbert and Sullivan
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Exercise
 And now practise your lists and typeset
 A bullet point list
 with (at least) two items
 Now try something more complicated: a list
 1 that can contain other lists inside itself.2 Isn’t LaTeX wonderful? It allows us
 1 to create beautifully looking1 tables,2 letters,3 formulae;
 2 to changedefault labelsin the itemize environment
 *** to pretty much anything I want.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Exercise
 Fill in the Mathematics section with the following expressions:
 Let α = 2. Then α2 = 4 and β̃ =√
 2.
 √3,√
 3 + 5√
 y ,
 √3 + 5√
 y + 7
 √y
 2;
 ∫ 25
 1zπθdz = x1 + x12 + x34.
 We know that
 sin x =∞∑n=1
 (−1)2n−1
 (2n − 1)!, (1)
 and so it follows that limx→0
 sin x
 x= 1.
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What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Footnotes
 The command
 \footnote{text}puts1 a footnote sign in the text 2 and a footnote at the foot of thepage. 3
 1Did you know that “put” is one the most common English words?2A footnote should be placed after the word or the sentence it refers to.3To avoid distraction, do not use footnotes unless absolutely necessary.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Including graphics
 There are several ways of including graphics in LATEX and you willmost likely need the graphicx and color packages.
 Creating graphics in LATEX is possible, but might be quitetime-consuming and you cannot create complex pictures. Forexample, in order to create this picture. . .
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 . . . I had to write the following code
 \setlength{\unitlength}{1cm} \begin{picture}(6,4)(0,-2) % \thicklines % \put(0,-1){\vector(1,0){10}} \put(1,-2){\vector(0,1){4}} % \put(3,0){\circle{1.4}} \put(3,0){\circle*{0.1}} \put(3,-0.3){$c_2$} \put(9,0){\circle{1.4}} \put(9,0){\circle*{0.1}} \put(9,-0.3){$c_1$} %
 \thinlines % \multiput(1,0)(0.4,0){20}{\line(1,0){0.2}} % \put(0.5,0.7){\line(1,0){2.5}} \put(0.5,-0.7){\line(1,0){2.5}} \put(0.6,0.7){\vector(0,-1){1.4}} \put(0.6,-0.7){\vector(0,1){1.4}} \put(0.2,0){$2r$} % \put(3.7,0){\line(0,-1){1.5}} \put(8.3,0){\line(0,-1){1.5}} \put(3.7,-1.4){\vector(1,0){4.6}} \put(8.3,-1.4){\vector(-1,0){4.6}} \put(5.5,-1.7){$d > 4r$} % \end{picture}
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 However, you can draw a picture elsewhere and then insert it inLATEX using special commands!
 To include PDF/PNG/JPEG graphics, e.g. file.png type
 \includegraphics[options]{file.png}The options are width, height, scale and angle.
 So, the command
 \includegraphics[width=2in, angle=60]{ctan lion 600.png}
 produces
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 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 If you want to add a caption, include the above syntax into thefigure environment:
 \begin{figure}[ht]\centering\includegraphics[options]{file.png}\caption{My figure}\label{the-label-for-cross-referencing}\end{figure}
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 The above algorithm works for PDF, PNG and JPEG files only ifthe latex file is compiled by the pdflatex command, i.e. theoutput file is .pdf.
 If the file format is not supported by pdflatex (e.g. GIF), justconvert it to, say, jpg first
 Filenames should not contain spaces.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 To include EPS graphics, which can be produced by Maple,Mathematica, Matlab, xfig and many drawing programs, exactlythe same algorithm is used.
 However, it only works if the compilation is done by the latexcommand, i.e. the output file is .dvi.
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What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 M.C. Escher, Waterfall
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Using the program called xfig you can draw figures and writeLATEX on them. Insert such figures into LATEX using the followingcommands:
 \begin{figure}[ht]\centering\input{file.pstex t}\caption{My figure}\label{the-label-for-cross-referencing}\end{figure}
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 input.png output.png
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Bibliography
 A bibliography can be typeset using the following syntax:
 \begin{thebibliography}{100} (widest label)\bibitem[label]{lamport} L. Lamport,\emph{\LaTeX - A Document Preparation System},Addison-Wesley, first edition (1985).\bibitem[label]{marker} ...\end{thebibliography}
 The item labeled marker can be refered to with the help of\cite{marker}.
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What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 BibTeX
 BIBTEX is a tool that generates a list of references from abibliographical database.
 You maintain one file in which you contain information aboutall possible articles you may wish to reference.
 You only specify the style and location of the bibliography.
 No need to retype the same references for your next article.
 A typical entry in a .bib file looks as follows:
 @BOOK{book:lamport,AUTHOR = {Lamport, L.},TITLE = {\LaTeX A Document Preparation System},PUBLISHER = {Addison-Wesley},YEAR = {1985}}
 For mathematical articles, this information can be copy-pasteddirectly from MathSciNet — go to “Select alternative format” andselect BIBTEX.
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 To create a BibTeX file (in LEd), go to
 File → New → Bibliography File in BibTeX format,
 and save it into the folder with your .tex file.
 To make use of the file, input the following commands before theend of the document:
 \bibliographystyle{style, e.g.alpha}\bibliography{name-of-file-without-.bib}
 You will also need to compile the document using the BibTeXcommand.
 There are many bibliography styles, see e.g.http://amath.colorado.edu/documentation/LaTeX/reference/faq/bibstyles.pdf
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 Labels and cross-referencing
 Every object that has a counter associated with it can be assigneda label using the command \label{marker}Once the label has been defined, it can be referred to later.Depending on the type of the object, the relevant command is
 \ref{marker}, \eqref{marker} or \pageref{marker}.For example,
 \section{Fermat’s Last Theorem} \label{sect:FLT}...We now prove Fermat’s Last Theorem defined in
 section \ref{sect:FLT}.produces
 1 Fermat’s Last Theorem. . .We now prove Fermat’s Last Theorem defined in section 1.
 Note that a document with references needs to be LATEXed twice.
 What is LaTeX?Typesetting rules
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 \begin{thm}[Wiles] \label{thm:FLT}The equation\begin{equation} \label{eqn:FLT}
 x^n + y^n = z^n\end{equation}
 has no solutions in integers for $n \geq 3$.\end{thm}The equation \eqref{eqn:FLT} from Theorem
 \ref{thm:FLT} is an obvious corollary to theTaniyama--Shimura conjecture.
 produces
 Theorem 2 (Wiles)The equation
 xn + yn = zn (25)
 has no solutions in integers for n ≥ 3.The equation (25) from Theorem 2 is an obvious corollary to theTaniyama–Shimura conjecture. The reader is encouraged to fill inthe details.
 http://www.ams.org/mathscinet/
 http://amath.colorado.edu/documentation/LaTeX/reference/faq/bibstyles.pdf

Page 18
                        

What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 The package hyperref extends the functionality of LATEXcross-referencing commands and (automatically) translatesreferences in the .pdf file, including the table of contents, intohypertext links.
 It also allows to type up clickable url’s, email addresses etc. Forexample,
 \href{http://Google.co.uk}{Google}\href{mailto:[email protected]}{my email}
 produces
 Google
 my email
 Make sure that hyperref is the last package to be loaded.
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 Writing letters
 Document class: letter
 Preamble:\signature{Your name}\address{Your house \\ street \\ town}\renewcommand{\today}{Month day, year} (optional)
 The letter environment:\begin{letter}{Recipient’s name \\ street \\ town}\opening{Dear John,}. . .\closing{Best wishes,}\ps{P.S. text}\cc{(cc:) text}\encl{(encl: ) list of enclosures}
 \end{letter}
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 Macros
 You can define your own commands using the following syntax:
 \newcommand{name}[num]{definition}
 For example, in order to produce∂L
 ∂xwe need to type
 \frac{\partial L}{\partial x}whereas if we put the following line in the preamble
 \newcommand{\pd}[2]{\frac{\partial #1}{\partial #2}}it is enough to type
 \pd{L}{x}If the command name is already defined, use \renewcommand.
 E.g. \renewcommand{\leq}{\leqslant} replaces ≤ with 6.
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 Exercise
 Pick your favourite famous person and describe theirbiography. Include this person’s picture, url the picture wasdownloaded from and (optional) books/articles/etc. that areassociated with them.
 Write a letter to the Belarussian Embassy in London explainingthat you would like to apply for a tourist visa. Include a list ofenclosed documents, your contact details and any otherinformation you may think is relevant.
 http://Google.co.uk
 mailto: [email protected]
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 All this was just the tip of the iceberg.
 With LATEX you can do much more!
 Examples include . . .
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 Drawing diagrams (package xy; the picture is from my thesis butthere are more in the manual)
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 Music typesetting (package MusixTeX; image taken from theMusixTeX manual)
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 Typesetting chemistry symbols (package mhchem; image taken fromthe mhchem manual)
 http://www.ctan.org/tex-archive/macros/generic/diagrams/xypic/xy/doc/xyguide.pdf
 http://icking-music-archive.org/software/musixtex/musixdoc.pdf
 http://www.ctan.org/tex-archive/macros/latex/contrib/mhchem/mhchem.pdf
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 Drawing trees (package Qtree; image taken from the Qtreemanual)
 What is LaTeX?Typesetting rules
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 Producing coffee stains (package coffee — not included instandard distributions)
 from the coffee manual
 What is LaTeX?Typesetting rules
 Additional Information
 Document structureText and formulaeMore LaTeX featuresEven more LaTeX features
 . . . and lots more . . .
 What is LaTeX?Typesetting rules
 Additional Information
 Errors and debuggingLaTeX on your home PCA few tipsLinks
 You should fix your errors starting with the first problem. Theoutput from the compiler will give you a line number to help youfind the error in your code, although keep in mind that the errormight have been generated by a text a few lines above it!
 Common LATEX errors include
 Undefined control sequence.\dcmentclass - a misprint.\mathscr{A} - need to load the mathrsfs package.
 Missing $ inserted.You left out a $ or \[ or \] somewhere when you were writingtext that needed to be in math mode.
 \begin{enumerate} input on line 9 ended with \end{document}An enumerate environment was opened but not closed.
 Extra alignment tab has been changed to \cr.You have too many &s in a row of a table or array or eqnarray.
 Something’s wrong - perhaps a missing $ item.
 http://www.essex.ac.uk/linguistics/external/clmt/latex4ling/trees/qtree/
 http://www.essex.ac.uk/linguistics/external/clmt/latex4ling/trees/qtree/
 http://hanno-rein.de/archives/349
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 To avoid errors:
 compile the document as often as possible;
 if the error is not obvious, try to do compilation by parts or(temporarily) replace complex structures with easier ones orcomment them out using %;
 use errors log and line numbers;
 having written \begin{xxx}, add \end{xxx} and only thentypeset the middle part;
 same for { and }.
 What is LaTeX?Typesetting rules
 Additional Information
 Errors and debuggingLaTeX on your home PCA few tipsLinks
 In order to have LATEX on your home PC, you will need to install
 TEX distributionMiKTeX (Windows), TeX Live (most common operatingsystems), proTeXt (Windows), teTeX (Unix compatiblesystems), MacTeX (Mac OS X), . . .
 LATEX editor (although you can write LATEX even in notepad)LEd (Windows), kile (Unix/Linux X-windows systems,Mac OS X), TeXnikCenter (Windows), iTeXMac2 (Mac OS X),Texmaker (Windows, Unix, Mac OS X), Emacs (most systems),. . .
 program(s) for viewing output LATEX filesYAP, Adobe Reader, . . .
 possibly something elseGhostScript, . . .
 What is LaTeX?Typesetting rules
 Additional Information
 Errors and debuggingLaTeX on your home PCA few tipsLinks
 Watch compatibility between various, particularly the newest,versions of software.
 Once everything has been installed, some settings may need to bechanged manually.For example, for the setup of these computers, I had to go toConfiguration → Options → Application → DVI Viewerand set
 TeX executables path to the bin folder of MiKTeX;
 GSDLL32.DLL and PostScript fonts paths to the bin directoryof the gs folder;
 TeX distribution to MikTeX2.7 (even though the one installedis 2.8!).
 What is LaTeX?Typesetting rules
 Additional Information
 Errors and debuggingLaTeX on your home PCA few tipsLinks
 You know we all becamemathematicians for the samereason: we were lazy.
 Max Rosenlicht
 Be lazy! Let LATEX do as much of your work as possible. Uselabels and cross-references,sectioning commands and theorem environments,enumeration environments and commands for changing thedefault style of numbering,array environments,macros,BIBTEX.
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 Distinguish between italic and roman fonts in math mode.Compare ∫ 1
 0e inxcosnxdx = 1 for n = 0
 and ∫ 1
 0einx cos nxdx = 1 for n = 0.
 Use roman alphabet fornon-mathematical symbols,differential d, exponential e, complex i and other reservedletters,functions like sin, cos, log etc. (for these you need to use thebackslash version, i.e. write \cos instead of cos).
 What is LaTeX?Typesetting rules
 Additional Information
 Errors and debuggingLaTeX on your home PCA few tipsLinks
 Add punctuation after equations and inside enumerationenvironments.
 Differentiate between
 - hyphen X-ray,– en-dash pages 1–12, Cauchy–Schwartz inequality, and
 — em-dash a punctuation dash — like this.
 How many authors does the Birch–Swinnerton-Dyer conjecture have?
 Do not use ” for quotation marks. Instead type
 two ` (grave accent) for opening quotation marks, andtwo ′ (vertical quote) for closing quotation marks.
 Don’t be frustrated if something doesn’t work out — Google isalways there to help you!
 What is LaTeX?Typesetting rules
 Additional Information
 Errors and debuggingLaTeX on your home PCA few tipsLinks
 The Not So Short Introduction to LATEX2e (on which the talkis based):http://www.tex.ac.uk/tex-archive/info/lshort/english/lshort.pdf;
 Wiki LaTeX textbook: http://en.wikibooks.org/wiki/LaTeX(and references therein);
 LEd: http://www.latexeditor.org;
 Kile: http://kile.sourceforge.net;
 iTeXMac2: http://itexmac.sourceforge.net;
 MiKTeX: http://miktex.org/;
 TeX Live: http://www.tug.org/texlive;
 The Comprehensive TeX Archive Network (CTAN):http://www.ctan.org;
 Detexify: http://detexify.kirelabs.org/classify.html;
 Google.
 http://www.tex.ac.uk/tex-archive/info/lshort/english/lshort.pdf
 http://en.wikibooks.org/wiki/LaTeX
 http://www.latexeditor.org/
 http://kile.sourceforge.net/download.php
 http://itexmac.sourceforge.net/
 http://miktex.org/
 http://www.tug.org/texlive/
 http://www.ctan.org/
 http://detexify.kirelabs.org/classify.html
 http://www.google.co.uk
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